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NNative Viewer (ActiveX) Installation Guide
This section contains the following sections:

• “About This Guide” in the next section

• “Revision History” on page 5

• “Technical Support” on page 6

• “Documentation” on page 6

• “Documentation Feedback” on page 6

About This Guide
This document provides detailed step-by-step installation and configuration instructions for 
successfully installing and setting up Veritas’s web-based Native Viewer. To enable native 
viewing simply requires the installation of ActiveX control.

Revision History
The following table lists the information that has been revised or added since the initial release 
of this document. The table also lists the revision date for these changes.

Revision Date New Information

May 2020 • Minor edits

March 2020 • Minor edits

October 2018 • Minor edits

June 2017 • Minor edits

July 2016 • Branding and minor edits

August 2015 • Remove support for IE8 and add support for IE11

• Remove Rights Management Guide

March 2015 • Image accessibility

• Branding and minor edits

October 2014 • IE requirements

• branding and edits

March 2014 • branding edits

December 2013 • minor edits



   PAGE: 6

Technical Support
Technical Support maintains support centers globally. All support services will be delivered in 
accordance with your support agreement and the then-current enterprise technical support 
policies.

For information about our support offerings and how to contact Technical Support, visit our 
website:

https://www.veritas.com/support

You can manage your Veritas account information at the following URL:

https://my.veritas.com

If you have questions regarding an existing support agreement, please email the support 
agreement administration team for your region as follows:

Documentation
Make sure that you have the current version of the documentation. The latest documentation is 
available from:

• Documentation link at the bottom of any page in the Veritas E-Discovery Platform landing 
page.

• Veritas Technologies LLC. All rights reserved. Products Web site: https://
www.veritas.com/product/a-to-z

Documentation Feedback
Your feedback is important to us. Suggest improvements or report errors or omissions to the 
documentation. Include the document title, document version, chapter title, and section title of 
the text on which you are reporting. Send feedback to:

eDiscovery.InfoDev@veritas.com

You can also see documentation information or ask a question on the Veritas community site.

https://vox.veritas.com/

Worldwide (except Japan) CustomerCare@veritas.com

Japan CustomerCare_Japan@veritas.com

https://www.veritas.com/support
https://my.veritas.com
https://www.veritas.com/product/a-to-z
https://vox.veritas.com/
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Native Viewer Installation GuideInstallation and Configuration

Overview
The Review and Redaction features in the Analysis & Review module include fully integrated 
functionality for viewing documents in native and near-native image format with the viewer 
option (“Native Viewer”) available in Document Review mode. The Native Viewer provides a 
view of Microsoft® Outlook, and Office documents equivalent to the view generated when 
printing the same document in the native application. Native viewing of a document enhances 
document review, especially for documents (such as Excel and PowerPoint) where graphs and 
charts are important to the meaning of the document.

The Veritas eDiscovery Platform’s viewer is web-based and does not require any installation of 
native applications on the user’s computer. Simply install an ActiveX control in the browser to 
enable native viewing.

Determine the Best Installation Method
When installing the Native Viewer, determine which Native Viewer installation methods is the 
best for your environment. The best method depends largely on the requirements of the 
organization deploying the application, as well as end users’ rights, or permissions on individual 
workstations.

On Demand versus Managed Deployment Installation Options

In general, if the Native Viewer must be installed on a single workstation, (used by only one 
person), and the user has “Power User” class or higher permissions, then the “On Demand 
Installation” is the best option for the end user. In every other scenario, the recommendation is 
to use the “Managed deployment” method. 

Prerequisites

Regardless of which installation approach you use, the Native Viewer requires installing the 
following prerequisite components, prior to running on a computer:

• Microsoft Windows

Windows Vista, Windows 7, Windows 8 (non Metro), Windows 10, Windows Server 2012 R2, 
and Windows Server 2016 are all supported operating systems. Due to the nature of the 
add-on application (delivery as an ActiveX control), use on other operating systems is not 
supported. In order to use this feature, a terminal services-based deployment is 
recommended to accommodate clients using other operating systems.

• Internet Explorer 11 or greater

The Veritas eDiscovery Platform supports IE 11. See Veritas Compatibility Matrix for details.
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Requirements

This section documents the permission requirements for each installation method.

Installation on Demand

When a user accesses the Review pane, and chooses the Native, Redaction, or Production views 
of a document, if the ActiveX control is not installed, the browser prompts the user to install the 
control. This control is installed on a per-user basis, rather than on a per-machine basis, and has 
the following additional requirements:

• User Account Control

User Account Control (UAC) must be disabled on a workstation in order to allow the user to 
install the Native viewer.

• User Rights

The Native Viewer is a signed ActiveX control. In order for a user to install the client control, 
their Internet Explorer browser needs to be configured to accept signed ActiveX controls, 
and must be enabled to run ActiveX controls. 

The user must also have the appropriate permissions to download and install the control. 
By default, most versions of Windows come with the Standard User and Restricted User 
roles. A user assigned to a group with the “Standard User” permission set is able to install 
the Native Viewer ActiveX control, but a user with only the “Restricted User” role cannot 
install Native Viewer ActiveX.

Users on systems using enhanced security (Windows Vista, Windows 7,and Server 2008) 
must be a member of a group which has installation privileges. Veritas recommends that 
users on these target systems are members of the Power Users group (or a group with 
greater privileges).

• Executable Content in User Profile 

Using this approach, files containing executable content (such as dynamic link libraries) will 
be installed in user profile folders. This content (following decompression) will amount to 
approximately 45 MB of data.

Managed Deployment

The eDiscovery Platform provides a Windows Installer-based (MSI) version of the control, which 
can be deployed on a per-machine basis. The behavior of the installer differs somewhat from 
the installation on demand approach, and is recommended for deployment scenarios where 
any of the following are true:

• Multiple users log into the system, either concurrently or not (such as terminal services, 
Citrix® environments, or shared workstations)

• Users have restricted permissions

• User account control cannot be disabled

• Roaming profiles are in use
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If moving forward with a managed deployment approach, an administrator can install the 
installer either on a baseline image, or deploy the installer using a push/pull deployment 
mechanism (such as Altiris™, SMS™, or Active Directory Group Policy). This requires two 
additional prerequisites:

• Microsoft Visual C++ 2008 SP1 runtime 

The Microsoft Visual C++ 2008 SP1 runtime must be installed. Without the runtime 
installed, users will encounter issues attempting to launch the viewer.

• Trusted Site 

Users accessing any/all eDiscovery Platform servers must be added to the Trusted Sites (or 
Local Intranet) zone of Internet Explorer. Without adding the site to one of these privileged 
zones, the system will revert to the behavior of the installation On Demand approach. This 
addition (or wildcard addition based on domain) can be done using a managed 
deployment approach as well.
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Native Viewer Installation GuideInstalling the Native Viewer (ActiveX)
Follow the set of installation steps for the installation method that best suits your needs. 

Installation on Demand
Note:  If you access the platform from a desktop that is shared by different Windows users, the 
Managed Deployment installation approach is recommended.

To install the Native Viewer (ActiveX control):

1. Navigate to the appliance and open a case for which Review and Redaction is enabled. Run 
a search, and click to view in Review mode.

2. On the review page, click the View drop-down menu and select Native/Image view.
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When you try to use the Native Viewer for the first time, the following warning might 
appear at the top of the browser.

"To help protect your security, Internet Explorer has restricted this webpage from running scripts 
or ActiveX controls that could access your computer. Click here for options..."

3. If a popup appears to refresh the browser, click Refresh. Otherwise, you may have to 
manually clear the browser and internet cache. 

4. Click the warning and accept the ActiveX install. A popup appears prompting for 
permission to install the viewer ActiveX control.

5. Click Install to begin.

When the installation completes, the document opens in native mode.

You have successfully installed and run the Native Viewer ActiveX control. If you have any 
difficulty installing the ActiveX control, contact Technical Support.
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Managed Deployment Installation
There are two general approaches for using a Windows Installer-based installer for the Native 
Viewer: Manual installation or Enterprise deployment.

In either case, an administrator will need to log in to the target computer, and run the Native 
Viewer installer.

Manual Installation

To install the Native Viewer using a Managed Deployment approach:

1. Log in to the target computer and run the Native Viewer (ActiveX control) installer.

Note:   The computer must have the Microsoft Visual C++ 2008 SP1 runtime installed. 
Without this runtime installed, certain components of the viewer will not work as expected; 
a warning appears if the component is not installed or out of date.
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2. Once complete, navigate to the utilities\NativeViewer folder and run the Native Viewer 
(ActiveX) installer. 

The InstallShield Wizard opens and guides you through the remaining steps for Native 
Viewer installation.

Once installation is complete, the Native Viewer becomes available for uninstall through 
the Control Panel (Veritas Native Viewer (ActiveX) 7.2).
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3. Finally, browse to an appliance, log on, and open a case to view in Review mode.

On the review screen, click the View drop-down menu and select Native/Image view.

If a yellow bar appears at the top of the page, it indicates that either: 

A. The computer does not have the viewer installed (verify through the Control Panel’s Add 
or Remove Programs utility). 

B. The site you are accessing is not a member of either the Local Intranet, or the Trusted 
Sites zone in Internet Explorer. As a member of either of these zones, the website has 
permission to launch the ActiveX control installed by the installer.

To validate that a site is in one of these trusted zones, from your browser, either: 

– Verify that the site in use either by going to File > Tools > Internet Options and clicking 
the Security tab (see Appendix),
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– Browse to the site, and check the status shown at the bottom right of the Internet 
Explorer window, in the status bar:

Enterprise Deployment

To deploy this product enterprise-wide, administrators can use any standard Managed 
deployment application. Veritas validates using both Microsoft Systems Management Server 
and Active Directory group policy (Software Installation) deployment as managed deployment 
applications.

Since this is a typical InstallShield installer, any of the InstallShield options can be used to 
manage the deployment. For example, to deploy the installer quietly, simply run the following 
command:

C:\WINDOWS>msiexec /I “Clearwell Native Viewer (ActiveX)7.2.msi” /qn

Administrators can use any of the standard Windows Installer commands. For more information, 
refer to Microsoft’s standard installer command line options at:

http://msdn.microsoft.com/en-us/library/windows/desktop/aa367988(v=vs.85).aspx

http://msdn.microsoft.com/en-us/library/windows/desktop/aa367988(v=vs.85).aspx
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Draft for Review - Veritas ConfidentialNative Viewer Installation GuideAppendix A: User and Internet Settings Reference
To see what type of an account a user has: 

1. From the Control Panel, double-click Users and Passwords (User Accounts in Windows XP). 

2. Select the user account and click the Properties button.

3. In the Properties dialog, select the Group Membership tab for the user group. 

To view your IE security settings:

1. In the Internet Explorer web browser, go to Tools > Internet Options.

The Internet Options window opens.
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2. Click the Security tab, then Custom Level.

The Security Settings window opens.

3. In the ActiveX controls and plug-ins section, select the following security settings:

– Download Signed ActiveX Controls = Prompt

– Run ActiveX Controls and Plug-ins = Enable

4. Click OK.
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Native Viewer Installation GuideAppendix B: Product Documentation
The table below lists the administrator and end-user documentation that is available for the 
Veritas eDiscovery Platform product.

Veritas eDiscovery Platform Documentation

Document Comments

Installation and Configuration

Installation Guide Describes prerequisites, and how to perform a full install of the Veritas eDis-
covery Platform application

Upgrade Overview Guide Provides critical upgrade information, by version, useful prior to upgrading 
an appliance to the current product release

Upgrade Guide Describes prerequisites and upgrade information for the current customers 
with a previous version of the software application

Componentized Virtualization 
Guide

Describes deployment of Veritas eDiscovery Platform utilizing multiple 
low-capacity virtual machines. Includes prerequisites and directions for 
configuration and installation.

Utility Node Guide For customers using utility nodes, describes how to install and configure 
appliances as utility nodes for use with an existing software setup

Native Viewer Installation 
Guide

Describes how to install and configure the Brava Client for native document 
rendering and redaction for use during analysis and review

Distributed Architecture 
Deployment Guide

Provides installation and configuration information for the Review and Pro-
cessing Scalability feature in a distributed architecture deployment

Getting Started

Navigation Reference Card Provides a mapping of review changes from 8.x compared to 7.x and the 
user interface changes from 7.x compared to 6.x

Administrator’s QuickStart 
Guide

Describes basic appliance and case configuration

Reviewer’s QuickStart Guide A reviewer's reference to using the Analysis & Review module

Tagging Reference Card Describes how tag sets and filter type impact filter counts

User and Administration

Legal Hold User Guide Describes how to set up and configure appliance for Legal Holds, and use 
the Legal Hold module as an administrator

Identification and Collection 
Guide

Describes how to prepare and collect data for processing, using the 
Identification and Collection module

Case Administration Guide Describes case setup, processing, and management, plus pre-processing 
navigation, tips, and recommendations. Includes processing exceptions 
reference and associated reports, plus file handling information for 
multiple languages, and supported file types and file type mapping

System Administration Guide Includes system backup, restore, and support features, configuration, and 
anti-virus scanning guidelines for use with Veritas eDiscovery Platform
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Load File Import Guide Describes how to import load file sources into Veritas eDiscovery Platform

User Guide Describes how to perform searches, analysis, and review, including detailed 
information and syntax examples for performing advanced searches

Export and Production Guide Describes how to use and produce exports, productions, and logs (privilege 
and redaction logs) 

Transparent Predictive Coding 
User Guide

Describes how to use the Transparent Predictive Coding feature to train the 
system to predict results from control data and tag settings

Audio Search Guide Describes how to use the Audio Search feature to process, analyze, search 
and export search media content

Reference and Support

Audio Processing A quick reference card for processing multimedia sources

Audio Search A quick reference card for performing multimedia search tasks

Legal Hold A quick reference card of how to create and manage holds and notifications

Collection A quick reference card of how to collect data

OnSite Collection A quick reference for performing OnSite collection tasks

Review and Redaction Reviewer's reference card of all redaction functions

Keyboard Shortcuts A quick reference card listing all supported shortcuts

Production Administrator's reference card for production exports

User Rights Management A quick reference card for managing user accounts

Online Help

Includes all the above documentation (excluding Installation and Configuration) to enable search across all 
topics. To access this information from within the user interface, click Help.

Release 

Release Notes Provides latest updated information specific to the current product release

Veritas eDiscovery Platform Documentation

Document Comments
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